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Introduction

You can use LibreOffice without requiring a pointing device, such as a mouse or trackball, by 
using the keyboard shortcuts that are available in Impress. Tasks as varied and complex as 
docking and un-docking toolbars and windows, or changing the size or position of objects can all 
be accomplished with using keyboard shortcuts. Although LibreOffice has an extensive set of 
keyboard shortcuts, each LibreOffice module has keyboard shortcuts that are specific to that 
module.

For help with LibreOffice keyboard shortcuts, or using LibreOffice with a keyboard only, search 
the LibreOffice Help using the “shortcut” or “accessibility” keywords.

In addition to using keyboard shortcuts, that are listed in this appendix, you can also define your 
own keyboard shortcuts. You can assign keyboard shortcuts to standard Impress functions or 
your own macros and save them for use with Impress only, or with the other modules in 
LibreOffice. To customize keyboard shortcuts to your requirements, see the Getting Started 
Guide for more information.

Impress keyboard shortcuts

Note

Some keyboard shortcuts are not available for computers using macOS. This is 
indicated in the following tables by a blank cell.

Impress functions

Windows
Linux

macOS Effect

F2 F2
Switches to text edit mode and opens the Text 
Formatting toolbar.

F3 F3 Enter and edit a group of objects.

Ctrl + F3  + F3⌘ Exit a group of objects.

Shift + F3 Shift + F3 Opens the Duplicate dialog of a selected object.

F4 F4
Opens the Position and Size dialog of a selected 
object.

Alt + Shift + F5 Alt + Shift + F5
Opens Notes view and displays the first slide in the 
slide show.

Ctrl + Shift+F5  + Shift + F5⌘ Opens the Navigator.

F6 F6
Forward navigation of the emphasis within the on 
screen elements without using mouse.

Shift + F6 Shift + F6
Backward navigation of the emphasis within the on 
screen elements without using mouse.

F7 F7 Start spelling checker.

Shift + F7 Shift + F7 Switches on or off the automatic spell checking.

Ctrl + F7  + F⌘ 7
Opens the Thesaurus dialog for the language being 
used. Impress has to be in text editing mode to access 
the thesaurus.
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Windows
Linux

macOS Effect

F8 F8 When selected, opens the Edit Points toolbar.

Ctrl + Shift + F8  + Shift + F8⌘ Fit text to frame of a selected object.

Shift + F10 Shift + F10 Opens the context menu of a selected object.

F11  + ⌘ T Open the Styles deck on the Sidebar.

Ctrl + Shift + M  + Shift + ⌘ M
Switches on or off the Impress edit mode. When 
switched off, a slide show is displayed in read only 
mode.

Slide shows

Windows
Linux
macOS

Effect

F5 Starts a slide show.

Shift + F5
Starts a slide show at the slide where the slide show was previously stopped 
at.

Esc Minus (-) Stop and close the slide show.

Spacebar
Enter
N
Down arrow
Right arrow
Page Down

If available, plays the next animation effect on a slide.
Shows the next slide

Backspace
P
Up arrow
Left arrow
Page Up

If available, plays the previous animation effect on a slide.
Shows the previous slide

Alt + Page Down Go to next slide without playing any animation effects.

Alt + 
Page Up

Go to the previous slide without playing any animation effects.

[Number] then 
Enter

Type the number of a slide and press Enter to show the slide.

Home Jump to first slide in the slide show.

End Jump to the last slide in the slide show.

B
. (period)

Show black screen until next key or mouse wheel event.

W
, (comma)

Show white screen until next key or mouse wheel event.
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Impress shortcuts

Windows
Linux

macOS Effect

Plus (+) Zoom in.

Minus (-) Zoom out.

Times (×) on 
number pad

Fits the slide to fill the Workspace view.

Divide (÷) on 
number pad

Zooms in on the selected object.

Ctrl + Shift + G  + Shift + G⌘ Group selected objects.

Shift + Ctrl + Alt +
G

 + Shift + ⌘
Option + G

Ungroup selected group.

Ctrl + click  + ⌘ click
Enter a group to edit individual objects in the group. 
Click outside the group to return to normal view.

Ctrl + Shift + G  + Shift + G⌘ Combine selected objects.

Ctrl + Shift + Alt +
K

 + Shift + ⌘
Option + K

Split a selected object that has been combined from a 
group of two or more objects.

Ctrl + +  + ⌘ + Bring to front.

Ctrl +Shift + +  + ⌘ Shift + + Bring forward.

Ctrl + -  + -⌘ Send backward.

Ctrl + Shift + -  + Shift + -⌘ Send to back.

Arrow Arrow
Moves a selected object in the direction of the arrow. 
Also moves a slide within the Workspace when no 
objects are selected.

Shift + Click and 
drag

Shift + Click and 
drag

Hold down Shift then click and drag when resizing an 
object to maintain the proportions of the object.

Shift + Click and 
drag

Shift + Click and 
drag

Constrains movement of a selected object horizontally 
or vertically when dragged.

Ctrl + Click and 
drag

 + Click and ⌘
drag

Hold down the Ctrl ( ) key, ⌘ then click and drag a 
selected object to create a copy of the object.

Alt + Click and 
drag

Option + Click 
and drag

Hold down the Alt (Option) key and draw or resize an 
object from the centre of the object.

Alt + Click Option + Click
Select an object that is behind the currently selected 
object.

Alt+ Shift + Click
Option + Shift + 
Click

Select an object that is in front of the currently selected 
object.

Shift + Click Shift + Click
Selects several adjacent objects or characters. Click at 
the start of a selection, move to the end of the 
selection, and then hold down Shift while you click.

Tab Tab Select objects in the order in which they were created.

Shift + Tab Shift + Tab
Select objects in the reverse order in which they were 
created.
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Windows
Linux

macOS Effect

Esc Esc Exit current mode.

Page Up
Switch to the previous slide. No function on the first 
slide.

Page Down Switch to the next slide. No function on the last slide.

Enter Enter
Activate a place-holder object in a new presentation 
(only if the frame is selected).

Ctrl + Enter  + ⌘ Enter

AutoLayouts in Impress use placeholders for slide titles,
text, and objects.
To select a placeholder, press Ctrl + Enter (  + ⌘ Enter). 
To move to the next placeholder, press Ctrl + Enter (  ⌘
+ Enter) again.
If you press Ctrl + Enter (  + ⌘ Enter) after you reach the
last placeholder in a slide, a new slide is inserted after 
the current slide using the same layout.

Editing text

Windows
Linux

macOS Effect

Ctrl + -  + -⌘ Inserts a custom hyphen in text at the cursor position. 
Also known as a soft hyphen.

Ctrl + Shift + -  + Shift + -⌘ Inserts a non-breaking hyphen in text at the cursor 
position. Also known as a hard hyphen.

Ctrl + Shift + 
Space

 + Shift + ⌘
Space

Non-breaking spaces. Non-breaking spaces are not 
used for hyphenation and are not expanded if the text is
justified.

Shift + Enter Shift + Enter Line break without paragraph change.

Left arrow Left arrow Moves the cursor one character to the left.

Shift + Left arrow Shift + Left arrow
Moves the cursor one character to the left and selects 
the character.

Ctrl + Left arrow
Option + Left 
arrow

Moves the cursor to the beginning of the previous word.

Ctrl + Shift + Left 
arrow

Option + Shift + 
Left arrow

Moves the cursor to the left and selects the word on the
left.

Right arrow Right arrow Moves the cursor one character to the right.

Shift + Right 
arrow

Shift + Right 
arrow

Moves the cursor one character to the right and selects
the character.

Ctrl + Right arrow
Option + Right 
arrow

Moves the cursor to the beginning of the next word.

Ctrl + Shift + 
Right arrow

Option + Shift + 
Right arrow

Moves the cursor to the right and selects the word on 
the right.

Up arrow Up arrow Moves the cursor up one line.
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Windows
Linux

macOS Effect

Shift + Up arrow Shift + Up arrow
Moves the cursor up one line in the text and selects the
lines of text.

Ctrl + Up arrow
Option + Up 
arrow

Moves the cursor to the beginning of the paragraph.

Ctrl + Shift + Up 
arrow

Option + Shift + 
Up arrow

Moves the cursor to the beginning of the paragraph. 
Selects the text in the paragraph from the cursor 
position to the beginning of the paragraph.

Down arrow Down arrow Moves the cursor down one line.

Shift + Down 
arrow

Shift + Down 
arrow

Moves the cursor down one line in the text and selects 
the lines of text.

Ctrl + Down 
arrow

 + Down arrow⌘ Moves the cursor to the end of the paragraph.

Ctrl + Shift + 
Down arrow

Opt + Shift + 
Down arrow

Moves the cursor to the end of the paragraph. Selects 
the text in the paragraph from the cursor position to the 
end of the paragraph.

Home Moves the cursor to the beginning of the line.

Shift + Home
Moves the cursor to the beginning of the line and 
selects the text from the cursor position.

Ctrl + Home
Moves the cursor to the beginning of the text block on 
the slide.

End Moves the cursor to the end of the line.

Shift + End
Moves the cursor to the end of the line and selects the 
text from the cursor position.

Ctrl + End
Moves the cursor to the end of the text block on the 
slide.

Ctrl + Del
Delete the text from the cursor position to the end of the
word.

Ctrl + Shift + Del
Delete the text from the cursor position to the end of the
sentence.

Ctrl + Backspace  + Backspace⌘ Delete the text from the cursor position to the beginning
of the word.

Ctrl + Shift + 
Backspace

 + Shift + ⌘
Backspace

Delete the text from the cursor position to the beginning
of the sentence.

Menu keyboard shortcuts

The keyboard shortcuts listed in the following tables are available in each menu category on the 
Menu bar. The tables give the menu item or sub-item, operating system validity, and the effect or 
purpose of the shortcut.
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Note

The menus listed below are in the same order as displayed on the Menu bar from left
to right.

File menu

Menu item or 
sub-item

Windows
Linux

macOS Effect

Open Ctrl + O  + O⌘
Opens the Open file browser so you can
navigate to a folder and select a 
document.

Save Ctrl + S  + S⌘ Saves the open document.

Save As Ctrl + Shift + S  + Shift + S⌘
Opens the Save as file browser so you 
can save the open document as a new 
document.

Print Ctrl + P  + P⌘
Opens the Print dialog so that you can 
select how you want to print the 
document.

Edit Menu

Menu item or 
sub-item

Windows
Linux

macOS Effect

Undo Ctrl + Z  + Z⌘ Undoes the previous editing action.

Redo Ctrl + Y  + Y⌘ Reverses the action of the last Undo 
command.

Cut Ctrl + X  + X⌘ Deletes the selected object and places it
on the clipboard.

Copy Ctrl + C  + C⌘ Copies the selected object to the 
clipboard.

Paste Ctrl + V  + V⌘ Places the object on the clipboard into 
the document.

Paste Special >
Paste 
Unformatted 
Text

Ctrl + Shift + Alt
+ V

 + Shift + ⌘
Option + V

Paste copied text at the cursor position 
without any formatting.

Paste Special >
Paste Special

Ctrl + Shift + V  + Shift + V⌘

Pastes the contents of the clipboard at 
the cursor position in a format that you 
can specify using the Paste Special 
dialog.

Select All Ctrl + A  + ⌘ A Selects all objects on a slide.

Points F8 F8
Opens the Edit Points toolbar if there is 
an object on the slide that uses editable 
points, for example a freeform line.
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Menu item or 
sub-item

Windows
Linux

macOS Effect

Edit Mode Ctrl + Shift + M  + Shift + ⌘ M
Switches on or off the Impress edit 
mode. When switched off, a slide show 
is displayed in read only mode.

View menu

Menu item or 
sub-item

Windows
Linux

macOS Effect

Rulers Ctrl + Shift + R  + ⌘ Shift + R
Switches the rulers off and on in the 
Workspace.

Sidebar Ctrl + F5  + F5⌘ Opens or closes the Sidebar.

Styles F11  + ⌘ T
Opens or closes the Styles deck on the 
Sidebar.

Navigator Ctrl + Shift+F5  + Shift + F5⌘ Opens the Navigator.

Insert menu

Menu item or 
sub-item

Windows
Linux

macOS Effect

Text Box F2 F2
Switches to text edit mode and opens 
the Text Formatting toolbar.

Hyperlink Ctrl + K  + K⌘ Opens the Hyperlink dialog.

Comment Ctrl + Alt + C  + ⌘ Option + C
Inserts a new comment box onto the 
selected slide.

Formatting 
Mark > Insert 
non-breaking 
space

Ctrl + Shift + 
Space

 + ⌘ Shift + 
Space

Inserts a non-breaking space at the 
cursor position.

Formatting 
Mark > Insert 
Narrow 
No-break 
Space

Ctrl + Shift+F5  + Shift + F5⌘ Inserts a narrow no-breaking space at 
the cursor position.

Formatting 
Mark > 
No-width 
Optional Break

Ctrl + /  + /⌘ Inserts a narrow no-width no optional 
break at the cursor position.

Format menu

Menu item or 
sub-item

Windows
Linux

macOS Effect

Text > Bold Ctrl + B  + B⌘ Applies Bold format to selected text.

Text > Italic Ctrl + I  + I⌘ Applies Italic format to selected text.
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Menu item or 
sub-item

Windows
Linux

macOS Effect

Text > 
Superscript

Ctrl + Shift + P  + ⌘ Option + C
Applies superscript format to selected 
text.

Text > 
Subscript

Ctrl + Shift + B  + ⌘ Shift + B Applies subscript format to selected text.

Text > Increase 
Size

Ctrl + ]  + ⌘ ] Increases the point size of selected text.

Text > 
Decrease Size

Ctrl + [  + [⌘ Decreases the point size of selected 
text.

Spacing > Line 
Spacing 1

Ctrl + 1  + 1⌘ Sets the line spacing in a paragraph to a
single line.

Spacing Line 
Spacing 5

Ctrl + 5  + 5⌘ Sets the line spacing in a paragraph to 
one and half lines.

Spacing > Line 
Spacing 2

Ctrl + 2  + 2⌘ Sets the line spacing in a paragraph to 
two lines.

Align > Left Ctrl + L  + L⌘ Sets the paragraph alignment to left 
aligned.

Align > Center Ctrl + E  + E⌘ Sets the paragraph alignment to center 
aligned.

Align > Right Ctrl + R  + R⌘ Sets the paragraph alignment to right 
aligned.

Align > Justified Ctrl + J  + J⌘ Sets the paragraph alignment to 
justified.

Lists > Demote
Shift + Alt + 
Right arrow

Demotes a point to the next level when 
Outline view.

Lists > Promote
Shift + Alt + 
Left arrow

Promotes a point to the next level when 
in Outline view.

Lists > Move 
Down

Shift + Alt + 
Down arrow

Shift + Option +
Down arrow

Moves a point down the order when in 
Outline view.

Lists > Move 
Up

Shift + Alt + Up 
arrow

Shift + Option +
Up arrow

Moves a point up the order when in 
Outline view.

Styles > 
Manage Styles

F11  + ⌘ T
Opens or closes the Styles deck on the 
Sidebar.

Object and 
Shape > 
Position and 
Size

F4 F4
Opens the Position and Size dialog of a 
selected object.

Arrange > Bring
to Front

Ctrl + Shift + +  + Shift + +⌘ Moves a selected object to the front of 
other objects.

Arrange > Bring
Forward

Ctrl + +  + +⌘ Moves a selected object in front of the 
forward object.

Arrange > Send
Backward

Ctrl + -  + -⌘ Moves a selected object behind the 
backward object.
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Menu item or 
sub-item

Windows
Linux

macOS Effect

Arrange > Send
to Back

Ctrl + Shift + -  + Shift + -⌘ Moves a selected object to the back of 
other objects.

Group > Group Ctrl + Shift + G  + Shift + G⌘ Group selected objects.

Group > 
Ungroup

Ctrl + Alt + Shift
+ G

+ ⌘ Option + 
Shift + G

Ungroup selected group.

Group > Enter 
Group

F3 F3 Enter and edit a group of objects.

Group > Exit 
Group

Ctrl + F3  + F3⌘ Exit a group of objects.

Slide menu

Menu item or 
sub-item

Windows
Linux

macOS Effect

New Slide Ctrl + M Ctrl + M Inserts a new slide into the slide show.

Jump to Last 
Edited Slide

Alt + Shift + F5
Option + Shift +
F5

Opens the last slide edited in the 
document.

Move > Slide to
Start

Ctrl + Shift + 
Home

Moves the selected slide to the 
beginning of the slide show.

Move > Slide 
Up

Ctrl + Shift + 
Up

 + Shift + Up ⌘
Arrow

Moves the selected slide above the 
previous slide. No function on the first 
slide.

Move > Slide 
Down

Ctrl + Shift + 
Down

 + Shift + ⌘
Down Arrow

Moves the selected slide below the next 
slide. No function on the last slide.

Move > Slide to
End

Ctrl + Shift + 
End

Moves the selected slide to the end of 
the slide show.

Navigate > To 
Previous Slide

Page Up
Switch to the previous slide. No function
on the first slide.

Navigate > To 
Next Slide

Page Down
Switch to the next slide. No function on 
the last slide.

Slide Show menu

Menu item or 
sub-item

Windows
Linux

macOS Effect

Start from First 
Slide

F5 F5 Starts a slide show from the first slide.

Start from 
Current Slide

Shift + F5 Shift + F5
Starts a slide show at the slide where 
the slide show was previously stopped 
at.
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Tools menu

Menu item or 
sub-item

Windows
Linux

macOS Effect

Spelling F7 F7 Start spelling checker.

Automatic Spell
Checking

Shift + F7 Shift + F7
Switches on or off the automatic spell 
checking.

Thesaurus Ctrl + F7  + F⌘ 7

Opens the Thesaurus dialog for the 
language being used. Impress has to be
in text editing mode to access the 
thesaurus.

Extension 
Manager

Ctrl + Alt + E  + Alt + E⌘ Opens the Extension Manager dialog.

Options Alt + F12 Opens the Options LibreOffice dialog.

Windows menu

Menu item or 
sub-item

Windows
Linux

macOS Effect

Closes Window Ctrl + W  + W⌘ Closes the active window. If there is only
one window, LibreOffice Impress closes.

Help menu

Menu item or 
sub-item

Windows
Linux

macOS Effect

LibreOffice 
Help

F1 F1
Opens your browser application at the 
LibreOffice Help pages.

Toolbar keyboard shortcuts

Impress provides several toolbars to help you to create slides and slide shows. Some of the tools
on these Impress toolbars can be activated by using a keyboard shortcut.

Note

The toolbars are listed in the same order that is displayed in the context menu that 
opens when you click on View > Toolbars on the Menu bar.

Drawing

Tool name
Windows
Linux
macOS

Effect

Insert Text Box F2
Switches to text edit mode and opens the Text Formatting 
toolbar.
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Tool name
Windows
Linux
macOS

Effect

Position and 
Size

F4 Opens the Position and Size dialog of a selected object.

Points F8
Opens the Edit Points toolbar if there is an object on the 
slide that uses editable points, for example a freeform line.

Form Design

Tool name
Windows
Linux

macOS Effect

Position and 
Size

F4 F4
Opens the Position and Size dialog of a 
selected object.

Bring to Front Ctrl + Shift + +  + Shift + +⌘ Moves a selected object to the front of 
other objects.

Send to Back Ctrl + Shift + -  + Shift + -⌘ Moves a selected object to the back of 
other objects.

Group Ctrl + Shift + G  + Shift + G⌘ Group selected objects.

Ungroup
Ctrl + Alt + Shift
+ G

+ ⌘ Option + 
Shift + G

Ungroup selected group.

Enter Group F3 F3 Enter and edit a group of objects.

Exit Group Ctrl + F3  + F3⌘ Exit a group of objects.

Image

Tool name
Windows
Linux

macOS Effect

Bring to Front Ctrl + Shift + +  + Shift + +⌘ Moves a selected object to the front of 
other objects.

Bring Forward Ctrl + +  + +⌘ Moves a selected object in front of the 
forward object.

Send Backward Ctrl + -  + -⌘ Moves a selected object behind the 
backward object.

Send to Back Ctrl + Shift + -  + Shift + -⌘ Moves a selected object to the back of 
other objects.

Line and Filling

Tool name
Windows
Linux

macOS Effect

Position and 
Size

F4 F4
Opens the Position and Size dialog of a 
selected object.

Bring to Front Ctrl + Shift + +  + Shift + +⌘ Moves a selected object to the front of 
other objects.
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Tool name
Windows
Linux

macOS Effect

Bring Forward Ctrl + +  + +⌘ Moves a selected object in front of the 
forward object.

Send Backward Ctrl + -  + -⌘ Moves a selected object behind the 
backward object.

Send to Back Ctrl + Shift + -  + Shift + -⌘ Moves a selected object to the back of 
other objects.

Show the 
Styles Sidebar

F11  + ⌘ T Opens the Styles deck on the Sidebar.

Outline

Tool name
Windows
Linux

macOS Effect

Demote
Shift + Alt + 
Right arrow

Demotes a point to the next level when 
Outline view.

Promote
Shift + Alt + 
Left arrow

Promotes a point to the next level when 
in Outline view.

Move Down
Shift + Alt + 
Down arrow

Shift + Option +
Down arrow

Moves a point down the order when in 
Outline view.

Move Up
Shift + Alt + Up 
arrow

Shift + Option +
Up arrow

Moves a point up the order when in 
Outline view.

Slide Sorter

Tool name
Windows
Linux

macOS Effect

Start from First 
Slide

F5 F5 Starts a slide show from the first slide

Standard

Tool name
Windows
Linux

macOS Effect

New Ctrl + N  + N⌘ Opens a new presentation document.

Templates Ctrl + Shift + N  + Shift + N⌘ Opens the Templates dialog to create a 
new document using a template.

Open Ctrl + O  + O⌘
Opens the Open file browser so you can
navigate to a folder and select a 
document.

Save Ctrl + S  + S⌘ Saves the open document.

Save As Ctrl + Shift + S  + Shift + S⌘
Opens the Save as file browser so you 
can save the open document as a new 
document.
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Tool name
Windows
Linux

macOS Effect

Edit Mode Ctrl + Shift + M  + Shift + M⌘ Switches on edit mode when a 
document is in read only mode.

Print Ctrl + P  + P⌘
Opens the Print dialog so that you can 
select how you want to print the 
document.

Cut Ctrl + X  + X⌘ Deletes the selected object and places it
on the clipboard.

Copy Ctrl + C  + C⌘ Copies the selected object to the 
clipboard.

Paste Ctrl + V  + V⌘ Places the object on the clipboard into 
the document.

Clear Direct 
Formatting

Ctrl + Shift + M  + Shift + M⌘ Removes direct formatting that has been
applied without using styles.

Undo Ctrl + Z  + Z⌘ Undoes the previous editing action.

Redo Ctrl + Y  + Y⌘ Reverses the action of the last Undo 
command.

Find and 
Replace

Ctrl + H  + Option + F⌘ Opens the Find and Replace dialog.

Spelling F7 F7 Starts the spelling checker.

Toggle 
Automatic Spell

Shift + F7 Shift + F7
Switches on or off the automatic spell 
checking.

Start from First 
Slide

F5 F5 Starts a slide show.

Start from 
Current Slide

Shift + F5 Shift + F5
Starts a slide show at the slide where 
the slide show was previously stopped 
at.

Insert Text Box F2 F2
Switches to text edit mode and opens 
the Text Formatting toolbar.

Insert Hyperlink Ctrl + K  + K⌘ Opens the Hyperlink dialog.

Standard (Single Mode)

Tool name
Windows
Linux

macOS Effect

New Ctrl + N  + N⌘ Opens a new presentation document.

Open Ctrl + O  + O⌘
Opens the Open file browser so you can
navigate to a folder and select a 
document.

Save Ctrl + S  + S⌘ Saves the open document.

Print Ctrl + P  + P⌘
Opens the Print dialog so that you can 
select how you want to print the 
document.
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Tool name
Windows
Linux

macOS Effect

Undo Ctrl + Z  + Z⌘ Undoes the previous editing action.

Redo Ctrl + Y  + Y⌘ Reverses the action of the last Undo 
command.

Insert Text Box F2 F2
Switches to text edit mode and opens 
the Text Formatting toolbar.

Position and 
Size

F4 F4
Opens the Position and Size dialog of a 
selected object.

Group Ctrl + Shift + G  + Shift + G⌘ Group selected objects.

Ungroup
Ctrl + Alt + Shift
+ G

+ ⌘ Option + 
Shift + G

Ungroup selected group.

Enter Group F3 F3 Enter and edit a group of objects.

Exit Group Ctrl + F3  + F3⌘ Exit a group of objects.

Start from First 
Slide

F5 F5 Starts a slide show from the first slide.

Start from 
Current Slide

Shift + F5 Shift + F5
Starts a slide show at the slide where 
the slide show was previously stopped 
at.

Standard (Viewing Mode)

Tool name
Windows
Linux

macOS Effect

Save As Ctrl + Shift + S  + Shift + S⌘
Opens the Save as file browser so you 
can save the open document as a new 
document.

Edit Mode Ctrl + Shift + M  + Shift + M⌘ Switches on edit mode when a 
document is in read only mode.

Print Ctrl + P  + P⌘
Opens the Print dialog so that you can 
select how you want to print the 
document.

Copy Ctrl + C  + C⌘ Copies the selected object to the 
clipboard.

Find and 
Replace

Ctrl + H  + Option + F⌘ Opens the Find and Replace dialog.

Start from First 
Slide

F5 F5 Starts a slide show from the first slide.

Text

Tool name
Windows
Linux

macOS Effect

Insert Text Box F2 F2
Switches to text edit mode and opens 
the Text Formatting toolbar.
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